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Mobiscope

Video from webcams on mobile —
for home surveillance or just for fun!

Mobiscope Desktop for Windows
Getting Started Guide
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Introduction

Mobiscope software consists of two components: the desktop part and the client module.
. The desktop part (Mobiscope Desktop) should be installed on your computer.
. The client module should be installed on your mobile device.

To view your web and network cameras on your computer through your handheld, you should
install both these components.

Appendix A provides the information about downloading and installation of Mobiscope Client on

your mobile device. In every Mobiscope Client you will also find directions on how to work with a
mobile client.

1. Installing Mobiscope Desktop on a computer

Mobiscope Desktop allows you to view up to four cameras (both ordinary web cameras and
network cameras) on your mobile device. You should install the desktop part of Mobiscope on all
computers with cameras which you're going to use. Run the installation executable file
mobiscope_desktop.exe and follow the instructions of the installation wizard to completely
install the product.

You can download this file from our site: www.mobiscope.com/download

Note: For correct work of the desktop, you should install this software with the account having
administrator privileges on the local computer.

If your computer isn't registered in Mobiscope Online Service, you should fill the registration form
while installing the Desktop.

& Mobiscope - Configuration Wizard SHECIHL X
File Help
Registration in Online Service
Step 2

Fill in both your name and email address in order to register in Online Service, Please
provide & valid email address. You wil receive a registration confirmation to this email
address.

Your name
|quhn

Email
|jnhn@smiﬂ1.cnm

Retype the email
|jnhn@smiﬂ1.com|

< Back Register

Offline

Note: Please specify existing email address in registration form exactly. You will receive automatic
notification about registration to this email address. You should confirm or cancel your registration in
'Mobiscope Desktop', by choosing one of the web links in this email.

In the Mobiscope Desktop each registered computer has a special computer number assigned at
registration in the service. If connection to Mobiscope Online Service has established and the
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registration was completed successfully, the uniqgue computer number will be assigned to your
computer. You will see this number in the desktop with title 'Mobiscope computer number'.
If the connection wasn't successful please verify proxy settings.

The Mobiscope Desktop connects to Mobiscope Online Service as usual Web browser (using HTTP
requests through port 80) and it doesn't require direct access to the computer or other special router
settings. But if in your local network the proxy server is used, you should specify proxy settings. For that, go
to the File menu, select Options...-Connection and enter all required information. Details about proxy
settings, you can get to know from your network administrator.

After registration you should add a password which you will use to access your computer with
cameras connected to it.

<@ Mobiscope - Configuration Wizard =SHAEE X
Eile Help

Ccomputer number: 20000602

Password

Create a password to access Mobiscope from Mabiscope Client and enter it here.
Remember that this password must match with the one you will enter in the Client. The
password is case sensitive,

Enter your password

oK

Online Mo active clients

After the installation is successfully completed, start the Mobiscope Desktop application. You
can find this item in Windows menu Start — Programs — Mobiscope.

In order to start working with Mobiscope Desktop, you should have the Mobiscope Desktop to be
running on your computer (it should have 'Online’ status in the Desktop).

& Mobiscope =HECIE X
Eile Help
computer number: 20000602
Cameras ]Recordings]
Select up to 4 cameras that you will work with
@ SERE [1] Mebwork camera #1
recording
[2] Live! Cam vWideo IM
Motion Detector [3] Logitech QuickCam Express
# settings [4] Z3MC USE PC Camera {Z5211)
‘:\ Camera
dmiif settings
E ,-% Scheduler
Online
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Note: If you have problems with your web camera, please first check if it is connected to the computer
properly and that it is not used by the other application. If you have problems with your netcam please
check settings of the camera according to its manual.

Windows Firewall window may occur at first launch of Mobiscope. You should press the button
Unblock to allow Mobiscope Desktop direct access. This will speed up Mobiscope performance. If
you select Keep blocking Mobiscope will also work.

2. Viewing cameras and recordings on the desktop

After you install both Mobiscope Desktop and Mobiscope Client you can start viewing your
cameras. You can select up to four cameras that you want to work with.

If you also want to view a network camera you should add it to the camera list. Click Add network

camera button @ and fill out the form.

& Add network camera = | =l

Metwork camera #1

MHetwork, addrezs [e.g. 170.64.121.23) Fort
1756412139 |

M anufacturer .
|Dnn't ko j &b Network camera test = | =
Camera preview
Mote:
If you are not zure about the manufacturer or the model of the
camera, you should leave the value "Don't know'' in the
drop-daown list.
[ Authorization
Refresh rate
1 second A
Test & Save ‘ Cancel Save I Back to edit ‘ Cancel test

- ’ e A

If you don’t know a manufacturer or a model of the camera, leave the value “Unknown” in the
drop-down list. After you enter all information about your camera press Test & Save button and
the connection to the network camera will be tested.

If the test was not successful you are recommended to get back and edit the camera. For that
press Back to edit button.

To delete a network camera from the camera list click Delete network camera button @ Or you
can just deselect the camera to stop viewing it.

You may switch the view from one camera to the other or view all cameras simultaneously. Use
buttons on the top of the camera view area or just click on the image from the needed camera.

B & & & &
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To view your video recordings, click on the tab Recordings and select the date in the calendar.
Then point the needed hour or the period in the hour in the timeline area. Red time intervals on
the timeline represent a record period when a motion was detected and the blue ones represent
the record period when there was no considerable motion. The grey intervals mean the time
periods with no recording.

& Mobiscope =HECIE X

Eile Help

computer number: 20000602 i@ online

Cameras Recordings ]

] o K =l By
9
% 27 22 29 0 1 2 10 @
31 4F=me 7 B 9 1
0 i1 72 13 14 15 16 12 J
17 18 19 2 21 2 13 13
24 25 2% 7 OB ¥ W 14 I mn
3 1 2 3 4 3 6 15
- B

00:00:00 f00:01:01

.
Jmfl o] [

Online Mo active clients

. -

After you select the period for playback, click the Play button. If you select the whole hour; all
record periods will be played one after another.

You could also convert recordings so they can be played back with any video player. For that
you should select the recording and press the convert button 3.

Note: Select the whole hour to convert the recordings of the hour into one video file.

You can also take a snapshot of your live camera or the recording at any moment. To do this click
the button on the top right of the camera view area *=.

3. Mobiscope Desktop settings

To use Mobiscope more effectively you may tune it up. You may determine general options of the
application, camera and motion detector settings and record schedule.

= Mobiscope Options

You may change general Mobiscope options. To open the window select the menu item Options
in the File menu.

You can select interface language, Mobiscope startup mode, connection settings and others.

Note: Pay attention to the Video storage settings. All recordings have a one week storage interval by
default. When it expires they will be deleted from Mobiscope Desktop!

To change the password for camera access from your mobile device, select Password change
section.

In Sound settings section you may select a microphone device to transmit sound to the mobile
device. You can get to know if the selected microphone is connected properly by watching the
changes of a current volume bar. To turn ON and OFF noise reduction, use the corresponding
checkbox.
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In Log section you may select to keep extended or detailed log. This may be useful if for some
reason Mobiscope Desktop crashes or the camera hangs.

< Options ﬁ
; Connection [ me=a s
J Please note that you have to install a proper languaage for your Client regardless of
the language installed on the Mobiscope.
_ﬁ? Password change
= IEninsh ;I
@ Audio settings — Mobiscope startup mode ——| [ Updates
N“ v Autostart Mobiscope ’7 v Auto check every 10 days
| Log
Video storage settings
Store recordings for [~ Limit disc volume for recording

I?_ﬂ day(s) Il_ﬂ Gb

Directory for recordings:
C:\Program Files\Mobiscopeymobiscope_server.dat

Save Cancel

= Camera Settings
Change camera settings to get more distinct image from your web camera.

@ Camera settings M

[1] Livel Cam Video IM

Brightness

' J

Contrast

. ]

Saturation

r S

Sharpness

' J

Gamma

. ]

I | v Auto

] v

[+ Backlight compensation

Expasure

r J

Settings |
Default | Save |

Y
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= Motion Detector Settings

Determine the motion detection level to sift out the most important movements. You may also
decide when the program must take action about the detected motion (every time the motion is
detected or according to the schedule).

You may define up to three rectangular areas for motion detection. Otherwise the whole frame will
be monitored for movement.

The above settings are made for each camera.

You may determine actions which Mobiscope will perform on motion detection (start recording,
send alert by email). These settings are the same for all cameras.

Note: Pay attention to the value of Turn Motion Detector on checkbox, please. It denotes when
Mobiscope must take action about the detected motion. If it is off (blue M) no actions will be taken except
the scheduled ones!

& Motion Detector settings l&ﬂ

[1] Live! Cam Video IM

[v Turn Motion Detector ON
Hote: Motion Detector will work regardless of the schedule

e A ﬁ ]
Motion detection level @ Area setup LJ

— .. »% B |

Motion level for current camera:
| 45 %

Define operations to be launched when motion is detected

Mote: The following settings are the same for all cameras
Record + Email +
v Send an email to
|john@smiﬂ1.com
Attach picture Format
Small A Plain text A
Send an alert not often than W Active aeal
T v Achve aea 2
v Only the first motion over the period to send

ok | ey 0k, Cancel

b = "o "

Email tab

The picture of every motion will be included in the email by default. You may define how often the
notifications should be sent. If you want to decrease the number of email notifications you may
select the longer time period in drop-down list.

Note that the size of each email is limited to 200 Kb. That is why if a letter mounts to this limit it
will be sent immediately and the setting Send alert not often than will be ignored. This may
happen if you choose to attach full size pictures to the email and there are many movements. To
decrease the size of emails you may select Only the first motion over the period to send
checkbox.

An email format may be chosen (HTML, Plain text). If you want to receive notifications right on
your BlackBerry, please select Plain text in the Format drop-down list.
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= Scheduler

To use Mobiscope when it is needed you may add some schedule items. You may decide whether
the video stream will be recorded continuously or the action will be taken only if a motion is

detected. In the last case you may choose cameras which will be kept track by Mobiscope’s Motion
Detector.
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